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EDIF Conversion Flow on Gateway

EDIF has been a vital part of the Electronic Design Automa- I Open, Workapmen
tion (EDA) industry for many years and Gateway allows
users to convert edif200 formatted files of other tools Lok v |y Ciiwor kWSha b WD i = i|_|1 b 111
vendors into Gateway’s schematics and symbols. 5
T edif. wer
STEP 1. Importing EDIF
You can import an edif from other tools into Gateway
with a menu, File>>Import. To enable this menu, you
have to load a workspace file that includes library paths
before importing. We recommend you to make a direc- File pame |_Gwen |
tory for this flow for example, name “testl” to the direc- Filo lype: [Werkapoos Fies (Paws) W |T|
tory then copy your edif file and following files from the ¥
installation directory. Figure1. Open Workspace.

C:\Silvaco\examples\gateway\2.2.7ZR (This is an instal-

. . When the conversion is OK, the successful message will
lation directory)

appear. You can see that there are (is) some new libraries,

examples.sws:  workspace file includes check the testl directory and you can see that there are
library path (is) new libraries here. Finally, you save the workspace
spicelib: basic symbol library from with File>>5ave Workspace.

Silvaco r
subcircuit: sample library from Silvaco E EDIF Im port @

In Gateway, you load examples.sws like Figure 1 and

- |
then load your edif file with the following menu \]_I): EDIF import successful

File>>Import>>EDIF200 as Figure 2. Click the Open,
starts a conversion.
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Figure3. Successful
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Figure.4 Imported top level schematic

STEP 2. Checking Imported Schematic
and Symbols

Generated libraries include symbol files (.body) and
schematics (.schlr). Open the top level schematic with
File>>Open>>Schematic, and check with your eyes
whether its connections, no lack of symbols and inheri-
tance of symbol parameters appear correctly.

STEP 3. Modifying Parameters

You can understand Library directories include symbols,
and they are used and referenced in schematics. Each
symbol has its own parameters. For example, a RES symbol
has a resistance parameter, a MOSFET has W and L and
so on. In Gateway, a parameter in a symbol consists of a
set of a parameter name and a value like “Name = Value”,
parameter names are usually set in its symbol file and
parameter values are in schematics. Since the symbol after
translating into Edif creates by omitting parameter names,
users need to add it by hand. An example of nmos4 symbol
in the analoglib shows below.

Figure 5.

Open two files, nmos4.body in analoglib and nmos4.body in
SpiceLib with Notepad and so on. and might see less or no
“P” lines in analoglib’s one. Cut and paste the red descriptions
in SpiceLib s to at the end of line in analoglib’s and save it.

=

40 30 “d” 40 30 0 0 12 0 L
40 0 “b” 40 0 0 0 12 0 L
00 “g” 000012 0L
40 -30 “s” 40 -30 0 0 12 O L
44 26 36 26 -1 0
44 34 44 26 -1 O
36 34 44 34 -1 O
36 26 36 34 -1 0
44 -4 36 -4 -1 0
44 4 44 -4 -1 0
36 4 44 4 -1 0
36 -4 36 4 -1 0
4 -4 -4 -4 -1 0
4 4 4 -4 -1 0
-4 4 4 4 -10
-4 -4 -4 4 -1 0
44 -34 36 -34 -1
44 -26 44 -34 -1
36 -26 44 -26 -1
36 -34 36 -26 -1
40 -15 40 -30 -1
20 -15 40 -15 -1
20 0 40 0 -1 O
15 15 15 -15 -1 0
0015 0 -1 0
40 -15 30 -20 -1 O
30 -10 40 -15 -1 0
20 -15 20 15 -1 O
40 15 40 30 -1 O
20 15 40 15 -1 O

<-- Paste red descriptions here.

[ e o o N o N e o e o e o o A A o e A L N N N e e R e O
o O O o o o

Figure 6. nmos4.body in analoglib.
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L 20 15 40 15 -1 ©

L 40 -15 40 -30 -1 0

L 40 15 40 30 -1 0

L 20 -15 20 15 -1 ©

L 15 15 15 -15 -1 0

P “SMARTSPICE” “@PREFIX@PATH %D %G %S %B

@MNAME S$SL SW $SAD $SAS $PD $PS SNRD $NRS &OFF#

IC=&VDSH##, &VGS##, &VBS# STEMP $DTEMP $M $GEO

S$SDELVTO” 40 40 0.00 0.00 12 0 0 0 0 0 0 1 O

P “WL” “(W\/L)” 60 -32 0.00 0.00 10 0 0 0 0 0 1 1 0

P “PATH”

won

62 0 0.00 0.00 12 0 OO 0OO0O1O00O0

P “"MNAME” "“?” 62 -16 0.00 0.00 10 0 0 0 0 01 0 O

P “PREFIX” “M” 40 0 0.00 0.00 12 0 0 0 0 0 0 1 O

P “L” “ 54 -32 0.00 0.00 10 0 0 0 0O 0 00O

P “W” “” 54 -48 0.00 0.00 10 0 0 0O O 0 O O O

P “AD” “” 62 -47 0.00 0.00 10 0 0 0 0 01 0O
P “AsS” “ 62 -63 0.00 0.00 10 0 0 0O 0O 0O1O0O
P “PD” “” 62 -79 0.00 0.00 10 0 0 0O 0O 01 0O
P “pS” “” 62 -95 0.00 0.00 10 0 0 0 0 0 1 0 O
P “NRD” “” 62 -111 0.00 0.00 10 0 0 0 0 0 1 0 O
P “NRS” “” 62 -127 0.00 0.00 10 0 0 0 0 0O 1 0 O
P “OFF” “” 62 -143 0.00 0.00 10 0 0 0 0 0 1 0 O
P “wDs” “” 62 -159 0.00 0.00 10 0 0 0 0 0 1 0 O
P “WGs” “” 62 -175 0.00 0.00 10 0 0 0 0 01 0 O
P “WBS” “” 62 -191 0.00 0.00 10 0 0 0 0 0 1 0 O
P “TEMP” “” 62 -207 0.00 0.00 10 0 0 0 0 0 1 0 O
P “DTEMP” “” 62 -223 0.00 0.00 10 0 0 0 0 01 0 O
P “M” “ 62 -239 0.00 0.00 10 0 0 0 0 01 0O

P “GEO” “” 62 -255 0.00 0.00 10 0 0 0 0 0 1 0 O
P “DELVTO” “” 62 -271 0.00 0.00 10 0 0 0 0 01 0 O

Figure 7. nmos4.body in spicelib.

In Gateway, open the workspace saved on the Step 1
and then open nmos4.body in analoglib. With the menu
Edit>>Properties, you open the edit symbol properties
panel and you will see that there are many parameters
you added in the body file. In this case, you need to set a
model name for MNAME because you have known the
fixed model name. Gateway allows users to set a prefix
value instead of “?” character for a value. The end of this
flow, final checking or netlisting detects this character a
value error. You need to do it in this stage.
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Figure 8. Edit Symbol Properties panel.

Also, click the SmartSpice button on the panel, and the
SmartSpice String Editor shows you netlist syntax
description for SmartSpice.

W Lditor

FREFDRPETE N N0 NG AR L L 5 TAD LA TR0 IPS FHRD BNES
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| il |

Figure9. SmartSpice String panel.

STEP 4. Open the Top Schematic Again

Now you can reference modified symbols, you open the
top level schematic with the workspace file and run a
menu Simulation>>View>>Spice Netlist. If no error you
get a netlist and create a control deck for simulation.

Conclusion

EDIF200 conversion flow finishes here. The STEP 3 might
take a long time for manual modifying, however once
modifying whole symbols in the analoglib from com-
petitors, you will reuse them from now on.
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HIPEX-CRC Parasitic RC-Network Reducer

Introduction

Design of large scale chips requires precise

HIPEX-CRC partitions the network

knowledge of interconnect delays. How- -
ever, detailed analysis of interconnects — 0
may quickly become computationally too =
expensive due to the distributed nature = ]
of the networks, and the large number of
internal nodes extracted.

into a set of smaller multiport com-
ponents (mpc)

HIPEX-CRC is a parasitic RC-network re-
duction tool able to reduce the huge num-
ber of elements produced by major EDA
parasitic extractors, including coupling
capacitors, and supports main industry
standards parasitic formats.

Advanced algorithm behind HIPEX-CRC
enables to maintain accuracy within a few
percents of Spice. HIPEX-CRC can be di-
rectly plugged to the HIPEX suite, but also
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HIPEX-CRC fits every multiport to
a realizable RC network with less
elements than the original network

can be used as a stand-alone tool. Figure 1.

Scattering-Parameter-Based Macromodeling
* HIPEX-CRC allows the user to preprocess the circuit,

making a first equivalent reduction by merging serie-

parallel elements and removing dangling elements

HIPEX-CRC Reduction Process

Parasitic Reduction

HIPEX CRC

Layout Design Parsing of Analysis
the netlist

« Spice simulation
« Timing analysis

Layout >
« Power analysis

« IR Drop, etc.

Integration in -

a graph with
equivalent
reduction

N

Parasitic
Extraction

|

Merging of
nodes based on
S-parameter
Macromodeling

Dump of the
reduced netlist

Figure 2. HIPEX-CRC flow.

Once the preprocessing is done, HIPEX-CRC relies
on a powerful Scattering-Parameter-Based Mac-
romodeling [1] reduction technique. The advanced
node merging rules within HIPEX-CRC lead to
the partitioning of the original network into a set
of several N-port component, each of which is then
modeled by a reduced RC circuit characterized by the
same set of S-Parameters (Figure 1)

This permits the analysis of interconnect models
other than RC-trees, and therefore, coupling capaci-
tors and resistor loops can be handled without loss of
generality

Also, partitionning of the circuit into small multiport
components leads to smaller size matrix computation,
saving time and memory, while increasing accuracy

Output of HIPEX-CRC is thus a realizable, simulable
reduced network. Figure 2 depicts the HIPEX-CRC
reduction flow

Key Features
e HIPEX-CRC supports SPICE, DSPF and SPEF input

formats and outputs SPICE, DSPF and SPEF reduced
netlists. Possibility is given to the user to output SPEF
from DSPF input, as well as output DSPF starting
from a SPEF output

The Simulation Standard
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Figure 3.

e HIPEX-CRC is fast: SPICE netlist ranging about 1.5
million parasitic elements can be processed within
some 5 minutes on a 64bit-Linux standard machine

¢ For enhanced reduction, HIPEX-CRC may ignore all
parasitic resistances and/or capacitances lower than a
user-specified threshold. Also, HIPEX-CRC may ignore
coupling capacitors present in DSPF or SPEF netlists

* For selective reduction, HIPEX-CRC may ignore
user specified subcircuits and/or SPF nets.

* For custom reduction, HIPEX-CRC enables the user
to specify unreducible nodes, to control topology of
the circuit

* Any reduction step performed by HIPEX-CRC is
reported to a summary file (detailed or simple, on the
user choice)

e HIPEX-CRC is easy to use, thanks to user-friendly
graphical interface, and flexible LISA scripting language

e HIPEX-CRC is available for Unix, Linux32-64bit,
Windows

pELTE LS SE.000 FE HlAREFSE

Lir

Figure 4.

Examples and Validation

1. Example #1

The RC tree network shown on Figure 3 is made of 26,000
elements (13,000 R and 13,000 C). A set of 10 external
ports was specified to carry out the reduction.

Symbol in dashed inset stands for a lumped RC segment
of 1000 resistances of 0.16 Ohm, and 1000 capacitances
of 5e-4 pF.

A reduction of 99.7 % was achieved on this circuit,
with 42 resistances and 32 capacitances in the reduced
network.

Figure 4 is the snapshot of a comparative SmartSpice
transient simulation of the original RC tree network
versus its reduced equivalent.

Worstcase voltage precision of the reduced circuit lies
within 2.5 % from that of original, while simulation time
was divided by 400.

2. Example #2
The RC tree network shown on Figure 5 is made of 80,000
elements (40,000 R and 40,000 C).

A set of 6 external ports was specified to carry out the
reduction.

Symbol in dashed inset stands this time for a lumped
RC segment of 4000 resistances of 0.25 Ohm, and 4000
capacitances of 15e-6 pF.

Again, a reduction of more than 99 % was achieved on
this circuit, with only 16 resistances and 15 capacitances
in the reduced network.

The comparative SmartSpice transient simulation of the
original RC-tree network versus its reduced equivalent is
shown on Figure 6.
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Figure 5.

Though only 6 external ports were specified, the worst-
case voltage precision was no less than 2.5 % again, and
simulation time was divided by 3000.

3. Example #3

Figure 7 is the snapshot of SmartSpice transient simula-
tions of reduced and original DSPF formatted industrial
networks.

The original network is made of 560 nets, for a total num-
ber of 34,464 RC elements.

HIPEX-CRC performed the reduction net by net ; per-
centage of reduction per net varies from 48% to 82%, ac-
cording to the topology of the net (regularity, fan-out of
internal nodes, ...etc), and the number of instance pins or
pins connected to it (the external ports).

Percentage of reduction for the global circuit was found to
be 71.6 %, and simulation time could be reduced by 50%.

Conclusion

HIPEX-CRC is an accurate,fast and flexible tool. Based
on Scattering Parameter Macromodels, the technique
behind guarantees the resultant equivalent network to
be fully compatible with general-purpose simulators.
Simulation time can be reduced by two or three orders of
magnitude, while the response of the reduced circuit is
within a few percents of that of the original network.

References
[

“Partitioning and Reduction of RC Interconnect Networks Based on
Scattering Parameter Macromodels’, H.Liao and W. Wei-Ming Dai,

Computer Engineering, University of California, Santa Cruz.
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Generic Devices -
The New HIPEX-NET Feature for Extraction of Custom Devices

1. Introduction

HIPEX-NET is SILVACO’s powerfull hierarchical lay-
out netlist extractor. Built-in extracting rules permit
to make fast and accurate parameter extraction for basic
set of devices as MOS, BJT, diode, capacitor and resistor.
But these rules can’t descibe all devices features and
parameters that appeare in new submicron or RF layout
designs. To resolve this problem the new HIPEX-NET
command HIPEX GENERIC_DEVICE has been intro-
duced. This new HIPEX-NET feature gives to user the
capability to extract not only additional parameters for
standard devices but also custom defined devices with
arbitrary set of parameters. This article describes the new
HIPEX-NET command.

2. Generic Device Command

The HIPEX GENERIC_DEVICE command is intended

to define devices that parameters are extracted by user-

defined LISA function. The command has the following
definition:

HIPEX GENERICDEVICE <body>
/ELEMENTNAME=<string>
/MODELNAME=<string>
[/AUX=<auxlayerl>, <auxlayer2s, . ,<auxlayerN>]

/PINS={{<pinlayerl>[, <pinnamel>]},

{<pinlayer2>[, <pinname2>]},
{<pinlayerM>[, <pinnameMs>]}}

/FUNC=<string>

[/FPARAM=<paramls>,.

[/BYSHAPE | BYNET]

[/SUBCKTFILENAME=<string>]

..,<paramL>]

body is the device recognition layer. Unlike It can be
several HIPEX GENERIC_DEVICE statements with the
same recognition layer. These statments should be dis-
tinguish by auxiliary and pin layers.

ELEMENT_NAME is device name. It can be PMOS,
NMOS, D, and other devices, or also can be arbitrary
name. It defines how the device will be reported to
netlist. In most cases, generic devices are reported as
custom SmartSpice devices. To report generic device as
the specific device into netlist the number and names of
pins, have the following values:

e for MOSFET (PMOS, NMOS, MN, MP, ME) and MESFET
(PMFE, NMF) devices have 3 or 4 pins with names: “D”,
“G” “S”, “SUB”. Fourth “SUB” pin is optional.

e for JFET (PJF, NJF) devices have 3 pins with names:
“Dr G,

¢ for BJT (PNP, NPN) devices have 3 or 4 pins with names:
“C’, “B, “E", “SUB'". Fourth “SUB” pin is optional.

e for resistor (R), capacitor (C), diod (D) and inductor (L)
devices have 3 pins with names “POS”, “NEG” and
“SUB”. Third “SUB” pin is optional.

If device name is CUSTOM_SUBCKT, the device will be
reported as subcircuit instance call.

MODEL_NAME is the model that is output to SPICE. It
can be several MODEL_NAMES for one <body> layer.

AUX is the list of auxiliary layers.

PINS is the list of pin layers with pin names. You can
omit the pin names for generic devices that should be
recognized as transitors, diodes, resistors, capacitors
devices. In this case, the order of pin layers is important
and the pins will get the following names:

e for MOSFET and MESFET devices, the order is
“D””G””S””SUB” that correspond to Drain, Gate,
Source, Substrate(Bulk).

e for JFET devices, the order is “D”,”G””S”,”SUB” that
correspond to Drain, Gate, Source,Substrate(Bulk).

e for BJT devices, the orderis “C”,”B”,”E”,”SUB” that cor-
respond to Collector, Base, Emitter, Substrate(Bulk).

e for two pins devices (diodes, resistors, capaci-
tors) with optional third substrate pin, the order is
“POS”,”"NEG”,”SUB” that correspond to first (positive)
pin, second(negative) pin, and Substrate.

FUNC is the user-defined LISA function for device pa-
rameter calculation.

FPARAM is a list of FUNC LISA function parameters.

BY_SHAPE or BY_NET is the option that defines how to
separate pins.

SUBCKT_FILENAME is a file name with subcircuit defi-
nition. This option works for device with ELEMENT _
NAME=CUSTOM_SUBCKT. In this case, the INCLUDE
statement is output to netlist instead of .MODEL state-
ment for this device.

There are several built-in LISA functions, that you can use
for device parameter calculation in your LISA procedure.
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3. Built-In LISA Functions

DEVICE_AREA(<layer]l_name>|<pinl_name>, <layer2_
name>|<pin2_name>)

This function calculates the overlaping area between
shapes from two layers or pins. If second parameter is
empty line (“”), the function calculates area of the shape
from first layer or pin.

L1l ‘ L1
‘ |
L2

L1

L1

£l

Figure 1. Calculated area in
DEVICE_AREA(“L1","L2")

DEVICE_PERIMETER(RELATION, <layerl_namelpinl_
name>, <layer2_name>|<pin2_name>)

This function calculates the length of the boundaries
for the shapes from layers or pins that are inputted as
parameters.

RELATION defines the relation between shapes from
two layers and it can take the following predefined
values:

e REL_NONE: The second layer or pin should be missed
“” is used), and the function calculates
perimeter of the shape from the first layer or pin.

(empty string

e REL_INSIDE: The length of edges of shape from first
layer that is strictly the INSIDE shape from second
layer.

K L1

L1

L1

Figure 2. Edges in DEVICE_PERIMETER
(REL_INSIDE,“L1","L2").

e REL_OUTSIDE: The length of edges of shape from
first layer that is strictly the OUTSIDE shape from
second layer.

L

EEle

Figure 3. Edges in DEVICE_PERIMETER
(REL_OUTSIDE, “L1","L2")

e REL_COINCIDENT: The length of common edges of
shape from first layer that is strictly the INSIDE shape
from second layer.

L1

L2

L1
L1

Figure 4. Edges in DEVICE_PERIMETER
(REL_COINCIDENT, “L1","L2")

e REL_BUTTING: The length of common edges of
shape from first layer that is strictly the OUTSIDE
shape from second layer.

K L1

L2

L1
- L1
H
Figure 5. Edges in DEVICE_PERIMETER
(REL_BUTTING,“L1","L2")
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e REL_COINCIDENT+REL_BUTTING: This is used
for calculation the length of common edges for both
shapes.

DEVICE_BENDS(<layer_name>|<pin_name>)

This functions calculates the bends value for the shape.
The bends value is the summing angle in degrees by
which the perimeter changes direction in all concave
vertices of the shape and dividing by 90ce.

h

bends=05 bends=1
bends="1 bends=2

Figure 6. Bends computation.

DEVICE_COUNT/(<layer_name>|<pin_name>)

This function returns number of separate shapes from
aux or pin layer or pin.

DEVICE_PIN_NET(<pin_name>)
This function returns net name of <pin_name>.

DEVICE_SET_PROPERTY(<property_name>,
erty_value>)

<prop-

This function set the device attribute in output netlists in
form <property_name>:<property_value>. <property_
name> is the string and <property_value> is the number.

4. Examples of Generic Device Definitions.

In example below, one layer P-Gate is used for recogni-
tion two PMOSes. First, one will be recognized only
when P-Gate layer shape has overlapped or touched the
Aux_gate layer shape. The pin names will have default
values. It will be reported to SPICE netlist as PMOS with
model name P0. The procedure PGATE calculates geo-
metrical parameters for this PMOS: L, W, PD, PS, AD, AS
that will be reported to SPICE file too. Second, one will
be recognized when P-Gate layer shape does not overlap
or touch the Aux_gate layer shape. The model name for
itis P1 and pin names have explicit definition.

PMOS device definitions:

hipex genericdevice P-Gate
/element name=MP
/auxs=Aux gate
/pins= P-SD, Poly, P-SD, NWell
/func=PGATEQ

/modelname=P0;

hipex genericdevice P-Gate
/element name=MP

/pins=({{*Poly”, “G"},
{~p-sD”,”D"}, {“NWELL,

{\\P_SDII, HS”},
\\SUB"}})
/func=PGATE

/modelname=P1;

Example of Lisa Function:

define procedure PGATE

do begin
W = 0.0;
L = 0.0;
PD = 0.0;
PS = 0.0;
AS = 0.0;
AD = 0.0;

! Calculation of gate area

AREA = devicearea(“P-Gate”,

\\II),.

W1l = device perimeter (RELBUTTING, “P-Gate”, “S”);

W2 = device perimeter(RELBUTTING, “P-Gate”, “D”);
! Calculation of gate width and length
/2

THEN

W = (Wl + W2)

IF (W NEQ 0.0) (L = AREA / W);

! Calculation of source, drain areas and perimeters

AD = devicearea(“D”, “");
AS = devicearea(“s”, “);
PD = device perimeter(RELNONE, “D”, “”);
PS = device perimeter(RELNONE, “S”, “”);

! Transfer of calculated parameters to c-code
deviceset property(“L”, L);

deviceset property(“W”, W);

deviceset property(“PD”, PD);
deviceset property(“*PS”, PS);
deviceset property(“AD”, AD);
deviceset property(“AS”, AS);

end;
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In the following example, the LISA function is defined
with parameters. Therefore, you can use the same func-
tion for a set of devices that contain different layers in its
definitions. L and W will be output as MOS parameters.

Device Definition:

hipex genericdevice “nmos”
/pins=({{*nsd”, “s”}, {“pcnodev”, “G"},
{*nsd”, “D”}, {“psubanalog”, “SUB”}})
/auxs={"rx”, “gatedc”}
/element name="NMOS"
/modelname="nmos"”
/func:”MOS_PROPERTIES"

/fparams= ({“nmos”,”nsd”,0});

LISA Function:

DEFINE PROCEDURE MOSPROPERTIES
PARAMETER mosseed
PARAMETER sdseed
PARAMETER bendeffect
DO BEGIN
AREA = devicearea((mosseed), “7);

W = device perimeter (RELBUTTING, (mosseed),
(sdseed)) / 2;

IF (W GTR 0) THEN (L = AREA / W)
ELSE (L = SQRT(AREA));
bends = devicebends((mosseed));

IF (bends GTR 0) THEN ( W = W - bends *
bendeffect * L ) ;

deviceset property(“L”, L);
deviceset property(“W”, W);

END;

In the example below, the inductor will be recognized
and reported to netlist as the instance of “spiral_std”
subcircuit with four parameters NR, W, S, and RAD.

Device Definition:

hipex genericdevice “inddev”

/pins=({{"METAL”, “PIN1”}, {“indpin”, “PIN2"},
{“substrate”, “PIN3"}})

/auxs:{“ind_hole", “indbottom”, “gapsnotend”,

“segsnotend”, “segs”}
/func="SPIRAL"
/element name="CUSTOM SUBCKT”

/modelname="spiralstd”;

LISA Function:

define procedure SPIRAL

do begin
nr = 0.0;
W = 0.0;
S = 0.0;
rad = 0.0;
nr = devicecount(“indbottom”) - 0.5;

end;

rad = device perimeter(RELNONE, “indhole”,
\\n) / 8,'

segscnt = devicecount(“segs”);

segs periint = device perimeter(RELINSIDE,

“segs”, “inddev”);
W = segs periint/(2*segscnt-1);
gapscnt = devicecount(“gapsnotend”);

gaps perisp = device perimeter(RELNONE,
“gapsnotend”, “)

device perimeter (RELBUTTING+RELCOINCIDENT,

“gapsnotend”, “inddev”);
S=gaps perisp/(2*gapscnt);
deviceset property(“NR”, nr);
deviceset property(“W”, W);
deviceset property(“S”, S);

deviceset property(“RAD”, rad);

5. Conclusion

The new HIPEX-NET feature extents the capability of
code. Generic device command gives users the possibil-

ity to extract new parameters and new custom devices
for submicron or RF layouts.
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Calendar of Events

September October Bulletin Board

1 1
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6 5 IEEE SOl Conf. - Charleston, SC
7 FSA Modeling WS - Santa Clara, CA Due to the new focus on the Verilog
8 6 IEEE SOI Conf. - Charleston, SC Eardwafe. PGSCffiﬁtlion Laﬂg‘;lgge Witg
; e acquisition of the assets of Simucal
? 0 7 ||:ES ? ES;pOplh((a)rcS)nEfXE)%hzggth(o;e, SC é Inc,, S(illvaco has joined Accellera. The
: : SILOS Verilog Simulator, Hyperfault
11 8 Mixed-Level Fault Simulator and Har-
12 9 mony Mixed-Signal Simulator all rely
13 10 on the stability of Verilog.
14 11
15 12 To improve designers’ productiv-
16 13 ity, the electronic design industry
17 14 needs a methodology based on both
worldwide standards and open
18 15 interfaces. Accellera was formed in
19 16 2000 through the unification of Open
20 ESSDERC - Leuven, Belgium 17 Verilog International and VHDL
21 ESSDERC - Leuven, Belgium 18 International to focus on identify-
22 ESSDERC - Leuven, Belgium 19 ing new standards, development of
. standards and formats, and to foster
;Z Egggggg - t:zzz:’ g::g:zz ;? the adoption of new methodologies.
25 22 Accellera’s mission is to drive world-
26 23 wide development and use of stan-
27 24 |EEE Compound Symposium - dards required by systems, semicon-
28 Monterey, CA ductor and design tools companies,
29 25 |EEE Compound Symposium - ;"hi,Ch er;har‘ct"; a languaﬁe'gaseg
esign automation process. Its Boar
30 Monterey, CA - of D;grectors guides };11 the operations
31 26 |EEE Compound Symposium - and activities of the organization and
Monterey, CA is comprised of representatives from
27 |EEE Compound Symposium - ASIC manufacturers, systems com-
Monterey, CA panies and design tool vendors.
28
29
30
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Hints, Tips and Solutions

SILVACO PDK Development Group

Q. How can I become a more efficient
user of Expert?

A. Maximize my layout viewing area
Default screen layout with many
toolbars around is sometimes incon-
venient; layout area can be maxi-
mized as desired by the user. You
may switch control bars on/off. Layer
Bar is resizable, both in height and in
width. Also toolbars can be docked/
undocked or dragged into another lo-
cation or completely turn off depend-
ing upon user’s desire.

Window Arrangements To simply
the management of opened windows,
the Window submenu provides fea-
tures that automatically arrange win-
dows to suit your needs into different
arrangements i.e Cascade, Tile, Tile
Vertically and Tile horizontally.

RN R - i R ]

1 WY F = RE

Figure 1. Tile Method.

Figure 2. Shortcuts Menu.

Shortcuts It is possible to assign keyboard
shortcuts to all menu commands, so that the
commands maybe quickly executed by hitting
the associated key instead of selecting them
from Menu. Also if you click the right-mouse
button inside the layout window, the custom
menu appears and it contains a user-definable
list of commands.

Scripting repetitive tasks Repetitive tasks or
a series of commands can be easily be scripted
using LISA and can be executed when desired,
hence saving time by automating the execution
of those commands rather than individually
executing them every time.

Edit in Place allows the user to select and edit
an instance of a cell at any level of hierarchy
within the current cell which is open in Expert.
During Edit in place session you may enter
into a cell instance, then enter into another
instance what belongs to first instance and so
on, going deeper and deeper into hierarchy.
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Q. How can I navigate through my layout?

a. Project Tree:

Project Tree (Hierarchy—> Explorer-> Proj
ect Tree) helps to view the libraries being
used in addition to the actual hierarchy of
a specific cell being used in a layout. This is
a convenient tool for fast loading, editing,
or inspecting any desired cell instance or
primitives at any level of hierarchy.

b. Cell hierarchy/explode heirarchy
features/create cell in place:
Cell Hierarchy is a powerful tool in EX-
PERT that makes it possible for a user-

created logical categorizing of layout into
subparts thus giving it a full hierarchical
mode of control. The key operations are
recursive Edit-in-place, hierarchical view
settings, hierarchy flatten (or explode),
and grouping into cells. Edit-in-place gives an easy
method of editing selected objects within the sur-
roundings of any of its instance.

c. Flat view/lazy view:

The View-> Cell view submenu controls the degree
of details in the layout being edited. There are several
options provided by Expert to change the contents of
the layout’s view or to make parts of the geometry
hidden. In View-> Cell view-> Flat mode enables the
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Figure 4. Using the Search Feature 1.

Figure 3. Navigating using Cell Map 1.

total and real geometry of the cells to be displayed.
The cell layout in fact looks like the hierarchy flat-
tened. In View- Cell view-> Lazy mode, only the
primitives/instances/arrays are displayed as hatched
boxes (with their insides hidden and only the top level
of hierarchy displayed). Some other modes of view
like the Floorplan mode, primitives’ mode, Edited
Cell Frame, Instances/array Frame etc.

d. Cell map:

By enabling the cell map (View-> Dock windows—> cell
map), a small additional window of the layout is
shown. It has a small navigational box (as shown in
Figure 3) that is convenient for resizing/focusing spe-
cific part of a big layout. It allows the user to view the
layout at different resolutions and to globally monitor
the changes made on the locally viewed area.

. Search feature:

In order to better identify specific layers of any shape
(box, eclipse, or region), or search for specific wire,
text, instances, arrays in a Cell hierarchy: there is a
“Search” option in the menu (Edit-> Search).

Call for Questions
If you have hints, tips, solutions or questions to contribute,
please contact our Applications and Support Department
Phone: (408) 567-1000 Fax: (408) 496-6080
e-mail: support@silvaco.com

Hints, Tips and Solutions Archive
Check our our Web Page to see more details of this example
plus an archive of previous Hints, Tips, and Solutions

www.silvaco.com
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